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Where to Find Help When You Need It 
 
Help from your Division/College’s Computer Consultant 
Some divisions and colleges have computer consultants assigned to them.  You can contact these 
consultants when you need help.  To determine if you have a consultant assigned to your division or 
college, look to: http://rohan.sdsu.edu/~facstaff 
 
Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative to provide all 
students, faculty, and staff with "baseline" access to information resources via networks, training in the 
uses of baseline hardware and software systems, and ongoing professional and technical support for 
utilization of computer resources at San Diego State University.  You can access the BATS Web Page 
by pointing your browser to: http://rohan.sdsu.edu/~bats/ 
 
Help in the San Diego State University, Faculty Room 
The Faculty Room is staffed Monday through Friday with computing consultants who will try to answer 
your questions.   
Location:    Adams Humanities, 1109 
Phone Number:   x45727 
Semester Hours:   7:30am – 6:00pm Monday -Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 

 
Help from the Faculty Computing Help Line 
Phone Number: x41348  E-mail: helpline@mail.sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
 
Help from the Staff Computing Help Line 
Phone Number: x40824  E-mail: staffhelp@sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
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OVERVIEW OF 
REPORTS 

 
 
 
 
 
 
 
 
 
 
 
 

Create a Report with 
a Wizard 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A report is an effective way to present your data, either by 
previewing it or by printing it.  You have control over the size and 
appearance of everything on a report.  You also can display the 
information the way you want to see it. 
 
Most of the information in a report comes from an underlying 
table, query, or another report, which is the source of the report's 
data. 
 
As in forms, reports use controls as graphical objects.  They can be 
text boxes that display names and numbers, labels that display 
titles, and decorative lines that graphically organize the data and 
make the report more attractive. 
 
 
1. In the Database window, click the Reports tab.  
 
2. Click New.  
 
3. In the New Report dialog box, click the wizard that you want 

to use.  
 
4. A description of the wizard appears in the left side of the 

dialog box.  
 
5. Click the table or query that contains the data you want to base 

your report on.  
 

 Note: Access uses this table or query as the default record 
source for the report.  However, you can change the record 
source in the wizard and select fields from other tables and 
queries.  

 
6. If you selected Report Wizard, the wizard dialog boxes that 

follow allow the user to select specific fields based on the 
table or query selected, group the report by field name, and 
select different styles of reports.  

 
7. If you selected Label Wizard, the wizard dialog boxes that 

follow allow the user to select a label type, change the font, 
create the label and sort the labels.  

 
8. If you click AutoReport: Tabular or AutoReport: 

Columnar, Access automatically creates your report, either in 
a tabular or columnar format.  If the resulting report doesn't 
look the way you want, you can change it in Design view.  
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Create a Report in 
Design View 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sections 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The design view for reports is similar to forms in that you work 
with controls as graphical objects.  They can be selected, deleted, 
copied, moved and formatted the same as with forms; i.e., the 
skills you learn in creating forms can be applied to reports. 
 
Reports are divided into more sections than they are in forms.  
Each section has a specific purpose, and prints in a predictable 
order on the page and in the report. 
 
To create a report in Design View: 
 
1. In the Database window, click the Reports tab.  
 
2. Click New.  
 
3. In the New Report dialog box, click Design View.  
 
4. Click the name of the table or query that contains the data you 

want to base your report on.  (If you want an unbound report, 
don't select anything from this list.)   

 
 
Sections are represented as bands, and in design view, each section 
that the report contains is represented once.  In the printed report or 
in Print Preview, some sections may be repeated many times.  You 
determine where information appears in every section by placing 
controls, such as labels and text boxes. 
 
The following is a list of sections of a report that can be seen in 
design view: 
 
Report Header 
 
This appears once at the beginning of a report.  You can use it for 
items such as a logo, report title, or print date.  The report header is 
printed before the page header on the first page of the report.  To 
insert report header and footer sections into the report, go into the 
View menu, and select Report Header/Footer.  
 
Page Header 
 
This appears at the top of every page in the report.  You use it to 
display items such as column headings.  To insert page header and 
footer sections into the report, go into the View menu, and select 
Page Header/Footer.  
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Group Header 
 
This appears at the beginning of a new group of records.  You use 
it to display information that applies to the group as a whole, such 
as a group name.  To insert group header and footer sections into 
the report, go into the View menu, and select Sorting and 
Grouping.  In the Sorting and Grouping dialog box, type the 
Group Name in the upper box.  If you want a group header or 
footer, select it in the Properties box below.  
 
Detail Section 
 
This contains the main body of a report's data.  
 
Page Footer 
 
This appears at the bottom of every page in the report.  You use it 
to display items such as page numbers.  
 
Report Footer 
 
This appears once at the end of the report.  You use it to display 
items such as report totals.  The report footer is the last section in 
the report design but appears before the page footer on the last 
page of the printed report.  
 
Group Footer 
 
This appears at the end of a group of records.  You use it to display 
items such as group totals.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To horizontally reduce or increase the size of a section, point to the 
associated band box on the vertical ruler located on the left of the 
screen.  When the mouse takes the shape of a cross with arrows on 
the horizontal line, drag it up to decrease or drag it down to 
increase the size of the section. 
 

Tip: If the data in the detail section, when previewed or printed, 
needs to be single-spaced, then drag the detail box up until it abuts 
the last control box in the detail section. 
 
If you want a header and not a footer section; for example, you 
might want a page footer, but not a page header, then drag the 
associated box on the vertical ruler up until no section is displayed 
for either the footer or header. 
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Sorting Records in a 
Report 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Group records in a 
report 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you used a wizard to create the report, you might not like the 
style on which it was based.  To change the style in design view, 
click the AutoFormat button on the toolbar to display the different 
styles available and then click OK. 
 

Tip: A control on a report that gets its contents from a field in 
the underlying table or query is known as a bound control.  To 
change the field in the underlying table or query to a different 
field, change the ControlSource property to the field name in the 
table, or query.  
 
 
You can sort reports based on up to 10 fields or expressions.  
 
1. Open the report in Design view.  
 
2. Click the Sorting And Grouping button on the toolbar to 

display the Sorting And Grouping box. 
 
3. In the first row of the Field/Expression column, select a field 

name, or type an expression.  
 
4. The field or expression in the first row is the first sorting level 

(the largest set).  The second row is the second sorting level, 
and so on.  

 
5. To change the sort order from ascending, select descending 

from the Sort Order list.  
 
 
You can group on up to 10 fields or expressions in a report.  
 
To group: 
 
1. Open the report in Design view. 
 
2. Click Sorting And Grouping on the toolbar to display the 

Sorting And Grouping box. 
 
3. Set the sort order for the data in the report. 
 
4. Click the field or expression whose group properties you want 

to set. 
 
5. Set the group properties in the following list.  
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Printing Reports 
 
 
 
 

Troubleshooting 
Reports 

 
 

You must set either GroupHeader or GroupFooter to Yes in 
order to create a group level and set the other grouping 
properties. 
· GroupHeader.  Adds or removes a group header for the 

field or expression. 
 
· GroupFooter.  Adds or removes a group footer for the 

field or expression. 
 
· Groupon.  Specifies how you want the values grouped.  

The options you see depend on the data type of the field 
on which you're grouping.  If you group on an expression, 
you see all the options for all data types. 

 
· GroupInterval.  Specifies any interval that is valid for 

the values in the field or expression you're grouping on. 
 
· KeepTogether.  Specifies whether Microsoft Access 

prints all or only part of a group on the same page. 
 
 
To print a report, click on the Print button on the toolbar, or go 
into the File menu and select Print.  The number of copies or 
specific pages of the report can be selected in the Print dialog box. 
 
 
If a report prompts for unexpected parameters, make sure that all 
field names used in the following areas of the report's design are 
spelled correctly and match field names in the underlying table or 
query: 
 
• ControlSource property of any controls.  
 
• Field/Expression column in the Sorting And Grouping box.  
 
• Expressions in controls or in the Sorting And Grouping box.  
 
If you get a blank page only at the end of a report, make sure the 
Height property is set to zero for the report footer. 
 
If every other page is blank, make sure that the total width of the 
form or report plus the widths of the left and right margins don't 
exceed the paper size specified in the Page Setup dialog box in the 
File menu.  The report width plus the right and left margin should 
be less than the paper size.  
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COMPACTING 
THE DATABASE 

Databases can be quite large, sometimes too big to save on one 
disk.  If you do not have a zip/unzip program, a tape drive or 
access to anything other than floppy disks, then use the backup 
utility that comes with Windows 95 to save a database on more 
than one floppy disk.  It can be found by going into the Start 
menu, Program folder, Accessories folder and System Tools 
folder.  Follow the instructions or go into the Help menu to find 
out how to backup your database. 
 
After deleting unnecessary tables, queries, forms or reports in a 
database, the size of the database does not necessarily decrease.  If 
you make significant deletions to clean up a database and want to 
reduce the size of the database to its real size, go into the Tools 
menu, point to Database Utilities and click on Compact 
Database.  It will take a few seconds for the database to be 
compacted resulting in one that is smaller in size.  

 


